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Instruction Manual

Content of this Instruction Manual

PSE is used for Picture Style Editor.

In this manual, the windows used in the
examples are from Windows XP.

» indicates the selection procedure of the menu.

(Example: [File] menu » [EXxit].)

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

** indicates a reference page.
Click to move to the relevant page.

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

 Switching Between Pages
Click on arrows on the bottom right of the screen.

(D : next page
€D : previous page

: return to a page you had previously
displayed

® Click on the chapter headings on the right side

of the screen to switch to the contents page of
that chapter. Also, click the item you want to
read about on the table of contents to move to
the relevant page.

© CANON INC. 2007 CT1-7143PSEWE-000
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.
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NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS Sjle s
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
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5.

TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with

restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be

illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in

the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the

SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU

HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Picture Style Editor (hereinafter, “PSE”) is software that allows you to edit Sys t em Req u | remen tS

Picture Style to your unique image characteristics and save them as Create Picture
original Picture Style files. Windows Vista*! Style Files
. . . Q1S Windows XP Professional/Home Edition*?2

What is a Picture Style file? Windows 2000 Professional*3

A Picture Style file (extension “.PF2") is an extended function of a PC with one of the above OS preinstalled (Upgraded Reference

Picture Style. It differs from the 6 preset Picture Styles (Standard, Computer | machines not supported) _ _

Portrait, Landscape, Neutral, Faithful and Monochrome) and * NET Framework 2.0 or later is required.*4

provides image characteristics that are effective in a very limited SRl Windows Vista 1.3GHz Pentium or higher

number of scenes. Windows XP, 2000 | 750MHz Pentium or higher

Main Features of PSE RAM Windows Vista Minimum 1GB

With PSE, you can use the functions below to edit Picture Style to Windows XP, 2000 | Minimum 512MB

your unique image characteristics and save them as original Picture Displa Screen resolution: 1024 x 768 pixels or more

Style files (extension “.PF2"). P Color quality: Medium (16 bit) or more

Select a Picture Style to be used as a basis for your images
Set the [Color Tone], [Color saturation], [Contrast] and
[Sharpness]
Make minute adjustments to a specific color
Adjust the brightness and contrast (gamma characteristic)
In addition, you can register the original Picture Style files you have
saved to a camera that has Picture Style settings and apply them to

shot images. You can also use Digital Photo Professional or RAW Im ag es fO I Adj u Stm ent

Image Task to apply them to RAW images.

*1 Compatible with 32-bit/64-bit systems for all versions except Starter Edition
*2 Compatible with Service Pack 2
*3 Compatible with Service Pack 4
*4 NET Framework is Microsoft software. It is installed together with PSE.

With PSE, you can use RAW images from the following camera models
Color man agem ent as sample images for adjustment and save them as original Picture

. : : tyle files.
Use PSE in a computer environment with color management. Style files

Also, set the profile of the monitor you are using and the color space EOS 40D
of the sample image to be used to perform the adjustments, etc. in
the preferences window (p.16).




Creating Original Picture Style Files

This section explains how to edit a Picture Style and save it as an original
Picture Style file using the various functions of PSE.

Preparing Sample Images.......cccooeevveeieiiiiieeeiiieeeeennn. 4
Starting Up PSE.......coo e 4
Opening a Sample IMage .......cccccceeeveeveeeviiiee e 4
A= 1T IR0V T s o [0 1 U 5
Enlarging a Specific Area ...........cccoeeeeeeeeevveiiiiiieeeeen, 6
Adjusting While Comparing with the Original Image.. 6
Navigator WindOW.............ucceiiiiieiiiiiiiee e 7
Setting the Warning Indicators...........cccccceeeiiieeiiennnns 7
TOOI Palette.......cuuiiiiiiiieee e 8
Pre-adjusting the Images ...........ccoovviiiieiiiiiiiie e 8
Correcting the Brightness .........cccevviiviiiii i, 8
Correcting the White Balance..............ccoccvviiiiiinn e, 9
Setting the Image Characteristics ...........ccceeeveveennnnnnn. 9
Selecting a Picture Style to Be Used as a Basis .......... 9
Using a Downloaded Picture Style File Effective for the
SCENE... oo, 10
Setting Color Tone, Color Saturation, Contrast and
SNAIPNESS. .. 10
Making Minute Adjustments to Color...........cccccvvvnnn... 11
Specifying the Color Directly............cooeeeieein. 13
Specifying the Color on the Color Wheel............... 13

Specifying the Color by Entering the Color Value.. 13
Displaying the Adjustment Color List and its Functions.. 13
Overlapping with the Range of Effect of Adjusted Colors 13

Deleting an Adjusted Color...........ccccvviiiiiiiiiinnnnne. 13
Color Display Mode and its Functions................cc...... 14
Adjusting Brightness and Contrast (Gamma
CharacteristiC) .......oooveeeeiiee 14

Saving the Adjustments as a Picture Style File....... 15
Using a Picture Style File .........ccocviiiiiiiiiiieee, 15
Registering a Picture Style File to the Camera........... 15
Using a Picture Style File with DPP.............c.oooooiiees 15
Using a Picture Style File with RIT ...........cccc 15
PreferenCes .o oo 16
EXItINg PSE......cooiei e 16
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Preparing Sample Images

PSE uses a sample image to perform the various adjustments and save
it as an original Picture Style file. For this reason, a sample image (p.2)
to be used for this purpose needs to be prepared in advance and saved
on your computer.

The settings performed in PSE are saved as a Picture Style file (p.15)
which is separate from the sample image, and the sample image used
to perform the adjustments itself is not affected at all.

Starting up PSE

Double-click the [Picture Style Editor] icon on the
desktop.
The main window (Description on the right) appears when PSE
starts up.

|§| You can also start up PSE from the camera software “EOS Utility”.
Refer to the “Function for Use with the Accessories” of “Reference”
in “EOS Utility Instruction Manual” (PDF electronic manual) for
details.

Opening a Sample Image
Open a sample image and perform various adjustments with that image
as a basis.

Drag and drop a sample image to the main window.

Drag and drop

=» The sample image is displayed in the main window with the
camera settings at the time of shooting.
=» The [Tool palette] appears.

|§| A RAW image that has been adjusted with Digital Photo
Professional (hereinafter, “DPP”) or RAW Image Task (hereinatfter,
“RIT”) and is then opened as a sample image with PSE will not have
the adjustments made in DPP or RIT applied to it.
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Introduction
Main Window

You can select the display magnification and the display method, etc. of the sample image. ,
Create Picture

Style Files

[:Z Picture Style Editor - [ C:\Documents and Settings\canon\Desktopd MG_0001.CR2 ] |Z||E|r5__<|
File  Edit ¥iew Tools Help

Reference
Image rotation
(90 degree units to
the left or right)
Before and after
adjustment
comparison display
(Top/bottom split)
(p.6)
0 . :
Before and after \%i(;(\)N/o (actual pixel size)
adjustment
comparison display
(Left/right split) (p.6) Full view
Normal screen m = Display magnification
IE————————————— (5ratios: 12.5%, 25%,
Cursor coordinates X:2377 Y: 637 HSL: 213, 5.78]>[213, 5,78) ( 0, 0, 0) ColorSpace:sRGB 50%, 100% and 200%)
position
Work color space display (p.16) @ @
Color values of the cursor position (Color display mode of [Tool palette]) (p.8, p.14)
(Before adjustment/after adjustment/difference between before and after adjustment) (8-bit conversion)



Introduction
Enlarging a Specific Area Adjusting While Comparing with the Original Image

You can enlarge a specific area in the main window to 100%. You can display before and after versions of an adjusted image in the
same window and perform adjustments while checking the adjustment Create Picture
In the main window, double-click the area you want results. Style Files
to enlarge.

e ———————— — Select [(E]] or [(E@]].
Reference
v I ;

= @ =5

Double-click —

Hi2382 ;602 HSL:[213, 5, 78]=[213, 5, 78] ( 0, 0, 0

»The image is displayed split top and bottom or left and right.

[[&]] (Top/bottom split) display

=

[(E0]] (Left/right split) displa

T — T [T T e e ——

CEE

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.
To change the display position, drag on the image or drag the
enlargement display position (p.7) in the [Navigator] window.
Double-click again to revert to the full view.

The image is displayed The image is displayed

before adjustment at the top, before adjustment on the left,
and after adjustment at the and after adjustment on the
bottom. right.



Navigator Window

In the main window, the display position of an image when its display
magnification is changed and the image histogram are displayed. You
can also set warning indicators to prevent excessive settings being
made.

Displaying the navigator window.
Select the [Display] menu » [Navigator].

MNawigator

Enlargement display position
Move the display position by
dragging

bead RGBE ] R | G | B ] Switches the histogram display

Histogram

---------- e VVarning indicator setting

& —— Warning range

|§| [Y] in the histogram display indicates luminance.

Setting the Warning Indicators

You can set warning indicators for luminance values (Y) and color
values (RGB) which are useful for preventing excessive settings being
made. Luminance and color value domains which are outside the set
range blink as warning indicators on images in the main window.

Checkmark [Show warning on images] and select [Y]
or [RGB].

__ )

=

Enter the upper and lower limit values of the warning

<~ range.

=» The domain where values are outside the upper and lower limit of
the range blinks on the image in the main window.

©® To stop the warning indicators, remove the check mark from the
[Show warning on images] checkbox.
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Tool Palette

You can adjust the image characteristics of the Picture Style file by using
the various functions of the [Tool palette].

Because the adjustments made with the [Tool palette] are immediately
applied to the image in the main window, you can check the results as
you work.

Select a Picture Style to be used as a basis (p.9)

Color Tone, Color saturation, Contrast,
Sharpness settings (p.10)

Load a Picture Style file (p.10)

Tool palette

Base Picture Style

Save a Picture Style file (p.15)

Minute adjustments to
a specified color (p.11)

Adjustment color list (p.13)

s Color display mode (p.14)

Adjust the brightness and contrast (gamma characteristic) (p.14)

|§| You can select the [View] menu P [Tool palette] to alternate the [Tool
palette] show/hide.

Pre-adjusting the Images

Sample images used in the adjustment process (p.2) which do not have
proper exposure or white balance can be adjusted using the
[Preliminary Adjustment] window to correct their brightness and white
balance.

However, please remember that adjustments made with the [Preliminary
Adjustment] window are merely pre-adjustments for correcting
adjustments made with the [Tool palette] (Description on the left). For
this reason, adjustments made with the [Preliminary Adjustment]
window are not saved in the Picture Style file which you create.

If the sample image used for making the adjustments has proper
exposure and white balance, you do not have to make adjustments with
the [Preliminary Adjustment] window.

Correcting the Brightness

# Select the [Tools] menu » [Preliminary Adjustment].
=» The [Preliminary Adjustment] window appears.
When the [Preliminary Adjustment] window appears, the display
switches to normal display, even if the main window display is
showing a comparison of an image before and after adjustment
(p.6).

" Adjust to correct the brightness of the image.

il
Preliminary Adjustment

Brightness adjustment

Drag to the left or right
to adjust

@

; . | e————r—
White balance adjustment

Reset |

Shot settings V| #* ]

close

The adjustments are applied to the image.
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Setting the Image Characteristics

- : You can adjust the image characteristics by using the various functions
Correcting the White Balance of the [Tool palettel.
Adjust to correct the white balance. All the adjustments made with the functions in the [Tool palette] become Create Picture

the image characteristics of the Picture Style file.

Style Files

Preliminary Adjustment

Brightness adjustment | FReset | a o =
. 5 — Selecting a Picture Style to Be Used as a Basis
‘White balance adjustment e Referen ce

) ) Select the Picture Style to become the basis of the adjustments from the
CI!Ck white balance 5 preset (except Monochrome) Picture Styles (Standard, Portrait,
Click the [ : ] buFton Landscape, Neutral and Faithful).
Td f[hen g“ci ona pocl)m(tj You can also register and use a Picture Style file effective for the scene
that'is to be the standar that you have downloaded from Canon’s web site.

for white
Enter the color temperature Select a Picture Style.
Select [Color Temperature] from the white balance
list box, and then drag the slider left or right Tool palette X

Select the white balance

Base Pictura Style

The adjustments are applied to the image. [ advanced.. | a | o |

B Show affected area on images
4
ES _ -

» The selected Picture Style is applied to the image.




Using a Downloaded Picture Style File
Effective for the Scene

Click the [[&']] button.

The [Open] window appears.

Select a Picture Style file to be registered and click
the [Open] button.
The selected Picture Style file is applied to the image.

|§| Original Picture Style files created with PSE (p.15) can also be
registered and used by following the procedure above.

Picture Style files compatible with PSE are files with the “.PF2”
extension.

Setting Color Tone, Color Saturation, Contrast and Sharpness

You can specify [Color Tone], [Color saturation], [Contrast] and
[Sharpness].

Click the [Advanced] button.
Tool palette fgl

Base Picture Style

] ST S

M Show affected area onimages

PR\ - |

» The [Advanced Picture Style Settings] window appears.

™ Drag each slider and then click the [OK] button.

Advanced Picture Style Settings @
Ol 2 3 4 5 6 7 B 9 10
Shapeness: ; _I“
4 3 -1 0+ +2 +3 +4
Contrast: H
d Drag the sliders left or
4 3 2 -1 0+ +2 +3 +4 . h t
Color saturation: - j rlg
4 3 2 -1 0 f+1 +2 +3 +4
Color Tone: J
S——

The settings are applied to the image.
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Making Minute Adjustments to Color

You can make minute adjustments to a color you have specified, using
the hue, saturation and luminosity functions in order to get the color you
want. You can also set a range for the effect on surrounding colors
which occurs when you adjust the colors you have specified.

Specify the color you want to adjust.
Click the [ ] button and then click the color you want to
adjust on the image.

Tool palette El

Base Pictura Style
[ soance Jar [

M Show affected area on images
4

The selected color is displayed as an adjustment point and as
[Z] on the color wheel.

) Introduction
Determine the range of effect for the color you want

to adjust.

Within the frame is the range of effect Create Picture

Style Files

Color of the adjustment point selected in step 1

Reference

Range of
upper and
lower limit of
luminosity
Drag to
move up or
down

Luminosity level of the adjustment
point selected in step 1

Range of upper and lower limit of saturation
Drag to move towards the center or towards
the outer perimeter

Range of upper and lower limit of hue
Drag to move towards the perimeter of the circle

Range of effect for hue can be set between 30 and 180 degrees.
Range of effect for saturation can be set between 30 and 100.
Range of effect for luminosity can be set between 30 and 100.

00
©
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) ] ] Introduction
Adjust the color. Check the range of application.

If you checkmark [Show affected area on images], the range of
application of the adjusted color blinks on the image. Create Picture
Style Files

Tool palette fz|

Base Picture Style _RESEt
Stardard ¥ e 5 O Reference

Show affected area onimages
4
a B W
Repeat steps 1 to 4 to adjust multiple colors.

You can select and adjust colors for up to a maximum of 100
spots.

Drag to the left or right to adjust

The color is adjusted to the range specified in step 2 and the
color of the image changes.

When dragging the slider, the point before adjustment [{1] and
the point after adjustment [ il ] will be displayed on the color
wheel.

00
©

12

|§| You can also specify the color to be adjusted in the different method
from the one explained in step 1 (p.13).



Specifying the Color Directly

In addition to specifying the adjustment point by clicking the color on the
image (p.11), you can also specify the color directly on the color wheel
or by entering the color value.

Specifying the Color on the Color Wheel
Click the [ ] button (p.112).

Click the color you want to adjust on the color wheel.

The selected color is displayed as an adjustment point [{1] on
the color wheel.

Specifying the Color by Entering the Color
Value

Select the [Edit] menu P [Specify the numerical
values for color adjustment].
The [Specify the numerical values for color adjustment] window
appears.

Enter the color value.
The entered color value is displayed on the color wheel as an
adjustment point [{Z3] on the color wheel.

Displaying the Adjustment Color List and its Functions

In addition to displaying colors before and after adjustment, the
adjustment color list (p.8) shows any overlapping of the range of effect
of adjusted colors, and has a checkbox for applying adjusted colors and
preventing adjusted colors from being applied.

— P mp— Color before adjustment

Color after adjustment

Y. ©

Displays any overlapping in the range of effect of adjusted colors
Remove the checkmark to prevent the adjusted colors from being applied

Overlapping with the Range of Effect of
Adjusted Colors

When you select an adjusted color from the list and [1'1:] appears, the
range of effect (p.11) of the adjusted color is overlapping with the range
of effect of other adjusted colors. Moreover, the overlapping areas will
be displayed in gray on the color wheel and the color is applied by
aggregating adjustment results.

To avoid an overlapping of the ranges of effect, select the subject color
which has a [(1}] and reset it so that the range of effect of the hue and
saturation no longer overlap, to make the [(T] disappear.

Deleting an Adjusted Color

Be aware that you cannot recover deleted colors.

From the list, select the adjusted color you want to

delete and then press the <Del> key on the keyboard.

The selected adjusted color is deleted.
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Color Display Mode and its Functions

You can select the color display mode which will be the basis for color
adjustment from three options (HSL, Lab or RGB) as well as check
values for adjusted colors.

Switches the color display
mode

Color value after adjustment
Color value before adjustment

When “HSL" is selected for the color display mode, you can only
change the color value for before adjustment by entering a
number.

|§| HSL is a color mode expressed by the three elements of hue (H),
saturation (S) and luminosity (L).
Lab is a color mode developed by the CIE (Commission
Internationale d’Eclairage) where L displays lightness, a displays
color elements from green to magenta and b displays color
elements from blue to yellow.
RGB is a color mode which expresses red (R), green (G) and
blue (B), the three primary colors (additive colors) of the visible
light spectrum.

Adjusting Brightness and Contrast (Gamma Characteristic)

You can adjust the brightness and contrast of a specific area using the
tone curve.

Adjust the brightness and contrast.

Click to add a [[]
(adjustment point) and
adjust by dragging

|

Input
Qutput

The setting value of the
selected point (you can
also enter numerical
values)

=» The brightness and contrast of the image change.

©® The horizontal axis shows the input level and the vertical axis
shows the output level.
The maximum number of [[J] is 10.
To delete a [[], either press the <Del> key on the keyboard or
double-click on the [[T].
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Saving the Adjustments as a Picture Style File

Adjustments specified in the [Tool palette] (p.9 to p.14) are saved on
your computer as an original Picture Style file (extension “.PF2").

The adjustments are saved as a Picture Style file which is separate from
the sample image, and the sample image used to perform the
adjustments itself is not affected at all.

Click the [[&]] button.

The [Save As] window appears.

Specify the file name and save destination and then
click the [Save] button.

If you do not want to show the settings adjusted in PSE,
checkmark [Disable subsequent editing] and save, so that the file
cannot be opened again in PSE.

Save As E]@
Save i | [ Desktop v| Q¢ * -
Y (L vy Documen ts
z f My Computer
MyRecent |4y Network Flaces
Documen s
f_ﬁgi
Desktop
Wy Document ts
58
My Computer
« ) Savesstps | FR2[pi2) v
2
My Metwrk Help
Caption
Copyright
[] Disahle suhsequent editing

The file is saved as a Picture Style file in the specified save
destination.

|§| Even if you checkmark [Disable subsequent editing] and save, you
can use the Picture Style file the same way as the Picture Style file
without chekmarking and saved (Description on the right). However,
you will no longer be able to open the Picture Style file in PSE. For
this reason, we recommend that you also save separately the
Picture Style file without checkmarking [Disable subsequent
editing].

Using a Picture Style File

Saved Picture Style files can be registered in the camera and applied to
shot images, or applied to RAW images using Digital Photo Professional
(hereinafter, “DPP”) and Raw Image Task (hereinafter, “RIT").

Introduction
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Registering a Picture Style File to the Camera

Picture Style files saved on your computer can be registered to the
“Camera that has a Picture Style function settings” (EOS-1D Mark I,
EOS-1D Mark II N, EOS 5D, EOS 40D, EOS 30D, EOS DIGITAL
REBEL XTi/400D DIGITAL) using EOS Utility and applied to shot
images.

Refer to “Applying Picture Style Files to the Camera” of “Chapter 2
Setting the Camera from Your Computer” in “EOS Utility Instruction
Manual” (PDF electronic manual) for details on operation.

Using a Picture Style File with DPP

Picture Style files saved on your computer can be applied to RAW
images using DPP.

Refer to “Using a Picture Style File” of “Chapter 3 Advanced Image
Editing and Printing” in “Digital Photo Professional Instruction Manual”
(PDF electronic manual) for details on operation.

Using a Picture Style File with RIT

Picture Style files saved on your computer can be applied to RAW
images shot with the “Camera that has a Picture Style function settings”
using RIT.

Refer to “Adjusting RAW Images” of “Chapter 3 Using High-Level
Functions” in “ZoomBrowser EX Instruction Manual” (PDF electronic
manual) for details on operation.

00
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Preferences Exiting PSE

You can perform color management settings such as specifying the In the main window, select the [File] menu » [Exit].

work color space for the RAW image displayed in the main window, or PSE exits

setting the profile for the monitor. ' Create Picture
Style Files

Select the [Tools] menu » [Preferences].

The [Preferences] window appears.
Select the item to be set, specify the required
settings and then click the [OK] button.

Default settings of WWork color space

® sRGB
) AdobeRGE

Color Management Setting

) sRGH
) Monitar Profile

|

The settings are applied.

|§| If you have changed the work color space during the adjustment
process, the adjustment point on the color wheel sometimes moves
16

in conjunction with the selected work color space.



Reference

This reference section has been provided to enhance your experience
using PSE.

It contains various troubleshooting solutions and how to delete PSE from
your computer.

Troubleshooting........cccviviiiiiiiii e, 18
Deleting the Software (Uninstalling) ........................ 18
About This Instruction Manual ..............cccccceeeeeenne. 19
Trademark Acknowledgments.............cccevvevvinnnnnnn. 19
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Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Troubleshooting

If PSE is not operating correctly, refer to the items below.

Introduction

Installation could not be completed correctly

You cannot install the software if a user setting other than [Computer
administrator] privilege or [Administrator] privilege is selected. Select
the [Computer administrator] privilege user setting in Windows XP or
the [Administrator] privilege user setting in Windows 2000. For
detailed information on selecting the user setting, refer to your
computer User’'s Manual.

PSE does not work

PSE does not operate correctly on a computer if its system
requirements does not meet. Use PSE on a computer with compatible
system requirements (p.2).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.2), if other applications are running at the
same time as PSE, you may not have sufficient RAM (memory). Exit
any applications other than PSE.

Images do not display properly

Sample images that are not supported by PSE (p.2) do not display.

Log in under the Computer administrator/Administrator privileges
when uninstalling the software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Select the [Start] button » [All Programs] » [Canon
Utilities] P [Picture Style Editor] » [Picture Style
Editor Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
=» The software is uninstalled.

Create Picture
Style Files

Reference
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

IBM is a registered trademark of International Business Machines
Corporation.

Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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